LIMITED WARRANTY AND LIMITATION OF LIABILITY

BY USING THIS SOFTWARE PRODUCT IN ANY MANNER, YOU ARE AGREEING TO ACCEPT THE FOLLOWING TERMS AND CONDITIONS.

Fluke Corporation (Fluke) grants you a non-exclusive right to use Fluke NORMA View software (Product) on a single PC or on multiple PCs. This grant of license does not include the right to copy, modify, rent, lease, sell, transfer or distribute the Product or any portion thereof. You may not reverse engineer, decompile, or disassemble the Product.

Fluke warrants that the Product will perform in its intended environment substantially in accordance with the accompanying written materials for a period of 90 days from the date of license acceptance. Fluke does not warrant any downloading errors or that the Product will be error free or operate without interruption.

FLUKE DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE AND THE ACCOMPANYING WRITTEN MATERIALS. In no event shall Fluke be liable for any damages whatsoever (including, without limitation, indirect, consequential, or incidental damages, damages for loss of business profits, business interruption, loss of business information, or other pecuniary loss) arising out of the use of or inability to use this Product, even if Fluke has been advised of the possibility of such damages.

Fluke Corporation
P.O. Box 9090
Everett, WA 98206-9090
U.S.A.

Fluke Europe B.V.
P.O. Box 1186
5602 BD Eindhoven
The Netherlands

11/2001

To register your product online, visit register.fluke.com
# Table of Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Getting Started</td>
<td>1-1</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>1-3</td>
</tr>
<tr>
<td></td>
<td>Features</td>
<td>1-3</td>
</tr>
<tr>
<td></td>
<td>Requirements</td>
<td>1-3</td>
</tr>
<tr>
<td></td>
<td>Hardware</td>
<td>1-3</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>1-3</td>
</tr>
<tr>
<td></td>
<td>Installation</td>
<td>1-4</td>
</tr>
<tr>
<td></td>
<td>Start Installation</td>
<td>1-4</td>
</tr>
<tr>
<td></td>
<td>Select Action</td>
<td>1-5</td>
</tr>
<tr>
<td></td>
<td>Select Interface</td>
<td>1-6</td>
</tr>
<tr>
<td></td>
<td>Configure</td>
<td>1-7</td>
</tr>
<tr>
<td></td>
<td>User Interface</td>
<td>1-7</td>
</tr>
<tr>
<td></td>
<td>Start Application</td>
<td>1-7</td>
</tr>
<tr>
<td></td>
<td>Main Window</td>
<td>1-11</td>
</tr>
<tr>
<td></td>
<td>Pull-Down Menus</td>
<td>1-11</td>
</tr>
<tr>
<td></td>
<td>Command Buttons</td>
<td>1-12</td>
</tr>
<tr>
<td></td>
<td>Channels</td>
<td>1-13</td>
</tr>
<tr>
<td></td>
<td>Configurations</td>
<td>1-13</td>
</tr>
<tr>
<td></td>
<td>Load Configuration</td>
<td>1-14</td>
</tr>
<tr>
<td></td>
<td>Save Configuration</td>
<td>1-15</td>
</tr>
<tr>
<td></td>
<td>New</td>
<td>1-15</td>
</tr>
<tr>
<td>2</td>
<td>Setting Up NORMA View</td>
<td>2-1</td>
</tr>
<tr>
<td></td>
<td>Channel Setup</td>
<td>2-3</td>
</tr>
<tr>
<td></td>
<td>Channel Table</td>
<td>2-3</td>
</tr>
<tr>
<td></td>
<td>Input Setup</td>
<td>2-4</td>
</tr>
<tr>
<td></td>
<td>Input Table</td>
<td>2-5</td>
</tr>
<tr>
<td></td>
<td>Integration Setup</td>
<td>2-5</td>
</tr>
<tr>
<td></td>
<td>Integration Setup Table</td>
<td>2-5</td>
</tr>
<tr>
<td></td>
<td>Timing and Sync Setup</td>
<td>2-8</td>
</tr>
<tr>
<td></td>
<td>Timing and Sync Settings</td>
<td>2-8</td>
</tr>
<tr>
<td></td>
<td>System Setup</td>
<td>2-9</td>
</tr>
<tr>
<td></td>
<td>System Information</td>
<td>2-9</td>
</tr>
</tbody>
</table>
# Fluke NORMA View

## Users Guide

### 3 Using NORMA View Basics

- Numeric .......................................................... 3-3
- Numeric Values .................................................. 3-3
- Delete Numeric Config ............................................... 3-4
- Delete Numeric ................................................... 3-4
- Save Data ......................................................... 3-5
- Save Data ......................................................... 3-5
- Data Saver Table .................................................. 3-6
- Data Table ......................................................... 3-6
- Chart Recorder .................................................... 3-7
- Chart .............................................................. 3-8
- Available Measurement .......................................... 3-10
- How to Select Measurement Function .................. 3-10
- Integration Available Functions ............................ 3-11
- How to Select Function ........................................ 3-11
- List of Plug-Ins ................................................... 3-11

### 4 NORMA View Plug-Ins

- Plug-In Installation .................................................. 4-3
- Installation Start .................................................... 4-3
- Select Action ........................................................ 4-4
- Installation of NORMA View Plug-In ..................... 4-5
- Motor Plug-In ....................................................... 4-5
- Description ......................................................... 4-5
- User Interface ....................................................... 4-5
- Table ................................................................. 4-6
- Status ................................................................. 4-6
- Numeric Panel Example ......................................... 4-7
- Analog Outputs Plug-In .......................................... 4-7
- Description ......................................................... 4-7
- User Interface ....................................................... 4-7
- Table ................................................................. 4-8
- Status ................................................................. 4-8
- Available Functions for Analog Outputs .................. 4-9
- How to Select Measurement Function .................. 4-9
- Harmonic Plug-In .................................................. 4-10
- Description ......................................................... 4-10
- User Interface ....................................................... 4-10
- Configuration Values ............................................ 4-11
- Graph ............................................................... 4-12
- Graph Buttons ..................................................... 4-14
- Table ................................................................. 4-15
- Status ................................................................. 4-17
- Buttons ............................................................... 4-17
- Harmonic Available Measurement ....................... 4-17
- How to Select Function ........................................ 4-18
- Storage Plug-In ..................................................... 4-18
- Description ......................................................... 4-18
- Requirements ....................................................... 4-18
- User Interface ....................................................... 4-18
- Configure Storage ............................................... 4-19
- Configure Storage Panel ..................................... 4-19
- Status ................................................................. 4-22
- Buttons ............................................................... 4-22
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Storage</td>
<td>4-22</td>
</tr>
<tr>
<td>Configuration Values</td>
<td>4-23</td>
</tr>
<tr>
<td>Graph</td>
<td>4-23</td>
</tr>
<tr>
<td>Graph Buttons</td>
<td>4-25</td>
</tr>
<tr>
<td>Table</td>
<td>4-27</td>
</tr>
<tr>
<td>Status</td>
<td>4-27</td>
</tr>
<tr>
<td>Buttons</td>
<td>4-27</td>
</tr>
<tr>
<td>Text File Format</td>
<td>4-28</td>
</tr>
<tr>
<td>Available Functions for Storing Data</td>
<td>4-29</td>
</tr>
<tr>
<td>How to Select Measurement Function</td>
<td>4-29</td>
</tr>
<tr>
<td>Available Functions for Sample Values</td>
<td>4-30</td>
</tr>
<tr>
<td>How to Select Function</td>
<td>4-30</td>
</tr>
</tbody>
</table>
# List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1.</td>
<td>1st Screen of Installation Program</td>
<td>1-4</td>
</tr>
<tr>
<td>1-2.</td>
<td>Select Action</td>
<td>1-5</td>
</tr>
<tr>
<td>1-3.</td>
<td>Select Interface</td>
<td>1-6</td>
</tr>
<tr>
<td>1-4.</td>
<td>Load Configuration Panel</td>
<td>1-8</td>
</tr>
<tr>
<td>1-5.</td>
<td>COM Port Configuration Panel</td>
<td>1-9</td>
</tr>
<tr>
<td>1-6.</td>
<td>COM Port Configuration Panel</td>
<td>1-10</td>
</tr>
<tr>
<td>1-7.</td>
<td>Main NORMA View Window</td>
<td>1-11</td>
</tr>
<tr>
<td>1-8.</td>
<td>Command Buttons</td>
<td>1-12</td>
</tr>
<tr>
<td>1-9.</td>
<td>Load Configuration Panel</td>
<td>1-14</td>
</tr>
<tr>
<td>1-10.</td>
<td>Save Configuration Dialog</td>
<td>1-15</td>
</tr>
<tr>
<td>2-1.</td>
<td>Channel Setup</td>
<td>2-3</td>
</tr>
<tr>
<td>2-2.</td>
<td>Input Setup</td>
<td>2-4</td>
</tr>
<tr>
<td>2-3.</td>
<td>Integration Setup Panel</td>
<td>2-5</td>
</tr>
<tr>
<td>2-4.</td>
<td>Stop Trigger Source-Int. Interval</td>
<td>2-7</td>
</tr>
<tr>
<td>2-5.</td>
<td>Timing &amp; Sync</td>
<td>2-8</td>
</tr>
<tr>
<td>2-6.</td>
<td>System Information Panel</td>
<td>2-9</td>
</tr>
<tr>
<td>3-1.</td>
<td>Numeric</td>
<td>3-3</td>
</tr>
<tr>
<td>3-2.</td>
<td>Numeric File Dialog</td>
<td>3-4</td>
</tr>
<tr>
<td>3-3.</td>
<td>Delete Numeric Configuration Panel</td>
<td>3-4</td>
</tr>
<tr>
<td>3-4.</td>
<td>Data Save Panel</td>
<td>3-5</td>
</tr>
<tr>
<td>3-5.</td>
<td>Date Saver Table</td>
<td>3-7</td>
</tr>
<tr>
<td>3-6.</td>
<td>Chart Recorder</td>
<td>3-8</td>
</tr>
<tr>
<td>3-7.</td>
<td>Y-axis Range</td>
<td>3-9</td>
</tr>
<tr>
<td>3-8.</td>
<td>Available Measurement</td>
<td>3-10</td>
</tr>
<tr>
<td>3-9.</td>
<td>Integration Available Functions</td>
<td>3-11</td>
</tr>
<tr>
<td>4-1.</td>
<td>1st Screen of Installation Program</td>
<td>4-3</td>
</tr>
<tr>
<td>4-2.</td>
<td>Select Action</td>
<td>4-4</td>
</tr>
<tr>
<td>4-3.</td>
<td>Choose Action</td>
<td>4-5</td>
</tr>
<tr>
<td>4-4.</td>
<td>Main Panel with Motor Button</td>
<td>4-5</td>
</tr>
<tr>
<td>4-5.</td>
<td>Configure Motor</td>
<td>4-6</td>
</tr>
<tr>
<td>4-6.</td>
<td>Numeric Panel Example</td>
<td>4-7</td>
</tr>
<tr>
<td>4-7.</td>
<td>Analog Outputs Panel</td>
<td>4-8</td>
</tr>
<tr>
<td>4-8.</td>
<td>Available Functions for Analog Outputs</td>
<td>4-9</td>
</tr>
<tr>
<td>4-9.</td>
<td>Main Panel with Spectrum Button</td>
<td>4-10</td>
</tr>
<tr>
<td>4-10.</td>
<td>Spectrum</td>
<td>4-11</td>
</tr>
</tbody>
</table>
4-11. Minimized Window with DFT Mode ................................................................. 4-12
4-12. Graphs .............................................................................................................. 4-13
4-13. Y-Axis Range .................................................................................................. 4-13
4-14. Graph Buttons ............................................................................................... 4-14
4-15. Table ................................................................................................................ 4-16
4-16. Spectrum Available Measurement ................................................................. 4-18
4-17. Main Panel with Storage Button ..................................................................... 4-19
4-18. Configure Storage Panel .................................................................................. 4-19
4-19. Select the Record Length in Second or MAX ............................................... 4-20
4-20. Start Trigger Source-Time .............................................................................. 4-22
4-21. Graph Storage ................................................................................................ 4-24
4-22. Y-Axis Range .................................................................................................. 4-25
4-23. Table ................................................................................................................ 4-27
4-24. Storage Available Functions .......................................................................... 4-29
4-25. Available Memory Storage Functions ............................................................. 4-30
Chapter 1
Getting Started

<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1-3</td>
</tr>
<tr>
<td>Features</td>
<td>1-3</td>
</tr>
<tr>
<td>Requirements</td>
<td>1-3</td>
</tr>
<tr>
<td>Hardware</td>
<td>1-3</td>
</tr>
<tr>
<td>Software</td>
<td>1-3</td>
</tr>
<tr>
<td>Installation</td>
<td>1-4</td>
</tr>
<tr>
<td>Start Installation</td>
<td>1-4</td>
</tr>
<tr>
<td>Select Action</td>
<td>1-5</td>
</tr>
<tr>
<td>Select Interface</td>
<td>1-6</td>
</tr>
<tr>
<td>Configure</td>
<td>1-7</td>
</tr>
<tr>
<td>User Interface</td>
<td>1-7</td>
</tr>
<tr>
<td>Start Application</td>
<td>1-7</td>
</tr>
<tr>
<td>Main Window</td>
<td>1-11</td>
</tr>
<tr>
<td>Pull-Down Menus</td>
<td>1-11</td>
</tr>
<tr>
<td>Command Buttons</td>
<td>1-12</td>
</tr>
<tr>
<td>Channels</td>
<td>1-13</td>
</tr>
<tr>
<td>Configurations</td>
<td>1-13</td>
</tr>
<tr>
<td>Load Configuration</td>
<td>1-14</td>
</tr>
<tr>
<td>Save Configuration</td>
<td>1-15</td>
</tr>
<tr>
<td>New</td>
<td>1-15</td>
</tr>
</tbody>
</table>
Introduction

NORMA View is a Microsoft Windows®-based software package that provides an easy-to-use, intuitive graphical interface to the Fluke Norma 4000/5000 Power Analyzer. NORMA View makes it easy to configure the power analyzer and recall data measurements. It has a fully featured stand-alone user interface for implementing functions as well as error checking and tracing.

NORMA View has been developed using LabVIEW 7, a graphical development system by National Instruments Corporation.

Note

Since the Release Date 30. 04. 2005 is required NI-VISA version 3.2 or higher.

Since the Release Date 25. 09. 2003 is NORMA View ported to LabVIEW 7, without back compatibility. See documentation for details.

Features

- Easy-to-use user color interface
- Modular application concept with dynamically loaded plug-ins
- Configuration storage to file in instrument memory
- Data measurement storage to disk in Excel-like format
- Multilanguage support
- Data measurement visible including the status of each measurement
- Based on LabVIEW Inopa01 instrument driver
- Error codes compatible with VISA standard

Requirements

Hardware

- Fluke Norma 4000/5000 Power Analyzer, firmware version V1.2 or higher
- PC with Pentium 500 MHz CPU or higher
- 64 MB RAM (256 MB or higher recommended)
- Graphics resolution: 1024 x 768, 256 color depth or higher

Software

- Operating system MS Windows NT4/2000/XP (Windows 2000 or XP recommended)
- NI-VISA Software for Windows Version 3.2 (included on installation CD)
Installation

Start Installation

1. Insert an installation CD with NORMA View software into your CD-ROM drive and wait for auto start.
2. Follow the on-screen instructions, (shown in Figure 1-1).
3. If the auto start feature is disabled in your computer, run setup.exe program in the NORMA View directory on your installation CD.

Figure 1-1. Starting the Installation Program
Select Action

The Select Action window opens only if the installer program detects NORMA View as already installed on your computer.

1. Select Reinstall to install the new version of NORMA View Basic (or reinstall the same version) as shown in Figure 1-2.
2. Select Uninstall to uninstall NORMA View Basic from your computer.
3. Select Install Plug-in(s) to install a plug-in to NORMA View. This option appears only if the installer program detects plug-in software on the install CD.

![Select the action window](exb002.bmp)

**Figure 1-2. Select Action**
Select Interface

The Select Interface window (Figure 1-3) opens only if the installer program fails to detect an installed GPIB driver. Choose the interface you want to use for communication with the instrument. The available options are:

- RS-232 - default communication instrument.
- GPIB/IEEE 488.2 and RS-232 - this option installs the drivers for GPIB communication card support.
- GPIB-ENET Network Interface and RS-232 - this option installs the support for GPIB-ENET communication box.

![Select Interface](exb003.bmp)

Figure 1-3. Select Interface
Configure

1. Press Next button to continue with the installation.
2. Choose the directory for NORMA View installation.
   The default installation directory is C:\Program Files\Fluke Norma\NORMA View.
3. Select where you want to create the program folder with program icons. The default folder is NORMA View.
4. Press Next button to finish the installation. The install program checks whether your PC has NI-VISA installed or not. If the install program fails to detect NI-VISA, it automatically installs the NI-VISA drivers.
5. After the installation completes, restart the computer to apply new settings.

Note

1. If you have installed NORMA View and the program doesn't work:
   - Open system Control Panel (Start->Settings->Control Panel). Select icon Add/Remove Program and find items NI-VISA (NI-VISA 3.2 Runtime) and GPIB driver (NI-488.2 1.70). Remove this item.
   - Repeat the NORMA View installation and select Reinstall.
2. If NORMA View was uninstalled, the NI-VISA 3.2 and GPIB driver 1.70 remain installed on your computer. To uninstall them, select Start->Settings->Control Panels->Add/Remove Programs and remove them manually.
3. If you have installed the NORMA View Release Date 23. 06. 2003 or older, the install program will ask you to confirm the uninstall request. The NORMA View Release Date 20. 09. 2003 is not compatible with older NORMA View versions. It is necessary to uninstall the previous version before the new version is installed.
4. If the operation system is Windows 98 (or older), it may be necessary to install LabVIEW 7 Run-Time (included on CD). Start LV_RTE_7.0\LVRunTimeEng70.exe to install LabVIEW Run-Time Engine.

User Interface

NORMA View offers an easy-to-use graphical interface with familiar pull-down menu items and command buttons. NORMA View operation requires the NORMA 4000/5000 instrument. Connect the instrument to the PC via a GPIB cable or serial cable or through the Ethernet.

Start Application

To start NORMA View, go to:
Start > Programs > NORMA View.

The application starts and the Load Configuration dialog box opens, as shown in Figure 1-4.
All available configurations display on the left side. The description of the selected configuration displays on the right side of the screen. If you are using NORMA View for the first time, only the Default and Factory configurations are available. If you saved a configuration during your last NORMA View session, the name of this configuration displays under the shadow line on the left side.

The Delete button removes the selected stored configuration (only a user-defined configuration can be deleted). The Exit button closes the dialog box.
The Continue button loads the selected configuration and opens the main display of NORMA View. Once you click Continue, the application performs initialization and starts searching for the instrument on the GPIB or serial port.

Be patient. If the instrument is connected through the COM port and the RS232 interface configuration is incorrect, initialization can take a few minutes as the application tries to find the instrument on all installed ports (including GPIB).

If the instrument is found, the application checks that it is a supported model. Supported models are listed in the Configure.ini file. If the model is not found in the list, a dialog box displays and requests the user to confirm communication with not supported model.

If the user answers No, then instrument search continues until communication is established. If no communication is established, the COM Setting panel displays, as shown in Figure 1-5.

Select the COM port or TCPIP and configure the parameters using Configure Settings button. For Serial Port, the setting window depends on operation system (standard window is used).

If you want to communicate over the TCPIP Socket, select TCPIP string and click Configure Settings button. The configuration panel displays, as shown in Figure 1-6.
1. Set the TCPIP Socket parameters.
   - Board - the Ethernet card in your computer. If only one card is present, set this parameter set to 0.
   - Address - sets the IP address of the instrument. Set the address in dot format: XXX.XXX.XXX.XXX (ex: 192.168.2.250).
   - Port - sets the Socket port. The NORMA 4000/5000 communicates on port 23. It is unnecessary to change the default value.

2. Click OK to confirm settings. The previous dialog box returns with the selected resource format: TCPIP[Board]:[Address]:[Port]:SOCKET (TCPIP0:192.168.2.250:23:SOCKET).

3. Use the OK button to confirm the setting. The application tests the instrument communication with new parameters.

4. Use the Exit button to close the dialog box.

   If the instrument communication is established and all plug-ins are successfully loaded, the main window displays, as shown in Figure 1-7.
Main Window

The main window is the top panel of the application (Figure 1-7). NORMA View enables users to configure the instrument and measurements, save data, load/save configurations, and view data measurement in graph format. The current selected configuration displays in brackets in the window title bar.

![Figure 1-7. Main NORMA View Window](exb009.eps)

To exit NORMA View, select File > Exit Program or click the window’s close button.

Pull-Down Menus

Pull-down menus in the main window allow the user to operate the instrument. Users can select the menu items with the mouse or keyboard shortcuts. The shortcuts are always the Alt key + underlined character in the item name (ex: File is shortcut Alt+F).

File

The File pull-down menu contains the entries to manage configuration, print panel, and exit application.

- New - opens new (Default) NORMA View configuration.
- Load Config - closes active configuration and displays the Load configuration dialog box.
- Save Config - opens File dialog box that asks the user for the name and description of the configuration to save. Press OK to save the configuration or press Cancel to return to the main window.
- Save Data - opens the Save Data dialog box. User can configure the stored data here.
- Print Panels - prints the open panels on the default printer. No printer selection is available.
- Exit Program - exits the application.

Setup

The Setup pull-down menu contains the entries to configure the instrument and measurements.

- Channels - opens the Channel Setup dialog box.
- Timing & Sync - opens Timing&Sync panel to configure timing and synchronization.
- System - opens System panel with system information.
- Inputs - opens the Input Setup panel.
- Integration - opens the Integration Setup panel.
• Delete Numeric Config - opens panel Delete Numeric Config. User can delete the stored numeric configuration.
• Numeric Refresh Rate - allows the user to select refresh rate of numeric panels.
• Optional Plug-ins, if installed, display under this line. See Chapter 4 for details.

Measure
The Measure pull-down menu contains entries to display measured values.
• Numeric - creates new Numeric panel.
• Close All Numerics- closes all opened numeric or chart recorder panels.
• Chart Recorder - creates new chart recorder (graph) panel.
• Optional Plug-ins, if installed, display under this line. See Chapter 4 for details.

Window
The Window pull-down menu contains entries to sort windows or to switch open window.
• Tile - tiles the opened panels.
• Cascade - sorts the opened panels to cascade.
• A list of open panels shows. Select the panel to bring to the front.

Help
The Help pull-down menu contains the entries Help and About.
• NORMA View Help - opens this help file.
• About - the About dialog box displays information about NORMA View and plug-ins if they are installed.

Command Buttons
The command buttons (see Figure 1-8) provide quick access to configuration or measurement panels. Use the Tip Strip to view a short description of each button’s functionality.

**Figure 1-8. Command Buttons**
1. Print Open Panel - the same as Print Panels menu entry. Prints the active panel on the default printer. No printer selection is available.
2. Hold Measurement - holds/runs the measurement. This action sends the command to the instrument.
Getting Started

Configurations

⑤ Create Chart Recorder Panel - the same as Chart Recorder menu entry. Creates new chart recorder (graph) panel. Refer section, Chart Recorder.

⑤ Set Timing - the same as Timing & Sync menu entry. Opens Timing&Sync panel to configure timing and synchronization. Refer section, Timing & Sync.

More buttons may display depending on installed plug-ins.

Channels

Displays settings and ranges of available channels.

Set Channel Ranges - the same as Channels menu entry. The area below the command buttons shows a list of available channels. Information displayed for each channel is channel name, range, and coupling. The label indicates an actual value as a percentage of the full scale. Click on a channel description to open the Configure Channel panel. For more information, see Chapter 2 Channel Setup.

Configurations

NORMA View enables the user to open multiple numerical or chart recorder panels, select display values, and specify the layout of open panels. These combined components comprise a configuration. NORMA View stores user-defined configurations to disk memory for later recall.

The Default configuration includes only one numeric panel with measurements on Phase 1 and loads all settings from the instrument. Factory Default configuration includes only one numeric panel with measurements on Phase 1 and resets the instrument to the default state.
Load Configuration

Users select a configuration from the Load Configuration dialog box. When you select to Load Config from the File menu, the running configuration stops and the Load Configuration dialog box displays as shown in Figure 1-9. Available configurations display on the left side. The description of a selected configuration displays on the right side of the screen.

If you use NORMA View for the first time, the Default and Factory Configuration configurations are available.

User-defined configurations display under the shadow line on the left side.

- Delete – removes the stored configuration (only user-defined configurations can be deleted).
- Exit – exits the Load Configuration mode.
- Continue - load selected configuration and start the main panel of NORMA View.
Save Configuration

You can save the active configuration. To open the Save Configuration Dialog Box shown in Figure 1-10:

1. Go to File > Save Config.
2. Type the name of the configuration in File Name text field or select the configuration name from the list. The configuration is stored to disk with this name and file extension '.cfg'.

Note
It is recommended to type a brief description of the measurement method, but not mandatory. The description displays on the right side in the Load Configuration dialog box.

3. Click OK to save the configuration with the selected name.

![Save Configuration Dialog]

Figure 1-10. Save Configuration Dialog

Note
If the file name already exists, the confirmation message dialog displays.

4. Click Cancel to return to main window without saving the configuration.

New

Selecting New from the File pull-down menu stops the running configuration and loads the Default configuration. The Load Configuration dialog box will not be displayed in such case.
Chapter 2
Setting Up NORMA View

<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Setup</td>
<td>2-3</td>
</tr>
<tr>
<td>Channel Table</td>
<td></td>
</tr>
<tr>
<td>Input Setup</td>
<td>2-4</td>
</tr>
<tr>
<td>Input Table</td>
<td></td>
</tr>
<tr>
<td>Integration Setup</td>
<td>2-5</td>
</tr>
<tr>
<td>Integration Setup Table</td>
<td></td>
</tr>
<tr>
<td>Timing and Sync Setup</td>
<td>2-8</td>
</tr>
<tr>
<td>Timing and Sync Settings</td>
<td></td>
</tr>
<tr>
<td>System Setup</td>
<td>2-9</td>
</tr>
<tr>
<td>System Information</td>
<td></td>
</tr>
</tbody>
</table>
Channel Setup

This Channel Setup dialog box, shown in Figure 2-1, enables the user to configure instrument channels. All changes are immediately sent to the instrument. The 1 to 12 channels versions are supported. To open the Channel Setup, go to the Setup menu and select Channels. Or, press the channel description (Set Channel Ranges) in the main panel.

![Figure 2-1. Channel Setup](eab014.bmp)

Channel Table

The number of rows depends on the number of active channels in instrument. This picture shows the six channels (three phase) version. To change channel configuration, change relevant parameter in window.

1. Type - description of channel cannot be modified.
2. Range - selects desired channel range. The ring offers only possible ranges. The units at current channels depend on input shunt setting (Refer section, Input) and on the state of the first button.
3. Scale Factor - sets the channel scale factor. Click on the box and write the value using keyboard or click on the spin on the left side to increment/decrement the value.
4. Coupling - selects desired coupling from ring.
5. Filter - switches the filter ON/OFF. The filter will be changed on all channels. The instrument doesn't allow turning the filter on/off on a single channel.
6. The status bar shows the performed action. If nothing is done, OK is displayed.
There are four buttons in the lower part of window.

② I [A]/I [V] - switches the current channel ranges between ranges in volt and ampere. This button has effect only if the external shunt is set for current channel. (Refer section, Input).

③ All Channels - if the change should be applied to all channels, switch this button on. If you change the parameter on the first channel (I1) now, all channels will be changed at a time. If the button All U or All I is turned on, it will be turned off.

To disable updating of all channels, switch the button off.

④ All U - if the change should be applied to all voltage channels (U channels), switch this button on. If you change the parameter on the second channel (U1) now, all voltage channels will be changed at a time.

⑤ All I - if the change should be applied to all current channels (I channels), switch this button on. If you change the parameter on the first channel (I1) now, all current channels will be changed at a time.

**Input Setup**

This Input Setup dialog box, shown in Figure 2-2, allows the user to configure the instrument’s current input parameters. All changes are sent to the instrument immediately. The software supports 1 to 12 channels versions. To open the Input Setup, go to the Setup menu and select Inputs.
**Input Table**

The number of rows depends on the number of active current channels in instrument. This picture shows the three channels version. To change input configuration, change relevant parameter in window. Click on the box and write the value using keyboard or click on the spin on the left side to increment/decrement the value.

1. Input - description of current input cannot be modified.
2. Shunt - selects desired input shunt. The ring offers internal or external. Selection of External shunt enables gain setting.
3. Gain - sets the input shunt factor (gain). This value is available only for external shunt.
4. The status bar shows the performed action. If nothing is done, OK is displayed.
5. All Channels - if the change should be applied to all current inputs, switch this button on. If you change the parameter on an input now, all inputs will be changed at a time. To disable updating of all channels, switch the button off.

**Integration Setup**

This panel allows configuring of integrated values. The panel Integration Setup can be opened using item Integration Setup from menu in main panel. Integrated functions are sent to the instrument with the button Send.

This panel shown in Figure 2-3, allows configuring of integration.

![Integration Setup Panel](ex016.bmp)

**Integration Setup Table**

1. Auto Clear - sets the auto clear state. If the auto clear is switched On, the integrated values are automatically zeroed after start integration.
2. Start Trigger - this cluster allows configuring the start integration conditions.
3. Source - selects the start trigger source from ring.
The available values are:

- **Immediate** - starts integration immediate after pushing Start button.
- **Time** - starts integration at exact time.
- **Manual** - integration is started with the button on the instrument.

Next displayed fields depend on selected source.

4. **Start button** - starts the integration. It is visible only for source Immediate.

**Time** - sets the start trigger time. Time is taken from the instrument not from PC. The format of the time is:

```
hh:mm:ss
dd/mm/yyyy
```

It is visible only for source Time.

5. **Stop Trigger** - this cluster allows configuring the stop integration conditions.

6. **Source** - selects the stop trigger source from ring. The available values are:

- **Immediate** - stops integration immediate after pushing Stop button.
- **Time** - stops integration at exact time.
- **Manual** - the integration is stopped with the button on the instrument.
- **Int. Interval** - stops the integration after selected number of seconds.

Next displayed fields depend on selected source.

**Stop Button** - stops the integration. It is visible only for source Immediate.

7. **Time** - sets the stop time. Time is taken from the instrument not from PC. The format of the time is:

```
hh:mm:ss
dd/mm/yyyy
```

It is visible only for source Time.

8. **Interval** - stops the integration. It is visible only for source Int. Interval (see Figure 2-4).
The status bar shows the performed action. If nothing is done, OK is displayed.

There are two buttons groups.

The buttons Add and Edit opens the panel like Integration Available Functions (Refer section, Integration Available Functions for details).

- **Add** - you can add the integrated function.
- **Edit** - you can edit integrated function in selected row of the table.
- **Delete** - you can delete integrated function from selected row of the table. This button stays inactive, if only one function is in the table.
- **Send** - sends the list of functions to the instrument. If no changes are made, this button is inactive. List of integrated values in instrument isn't changed, until this button is pressed.
- **Reset** - default setting of integration function is set.
- **Clear** - zeroes the integrated values.
- **On/Off** - starts/stops the integration. The integration has to be set On to be able select integrated values in measurement function list in Numeric or Graph. Don't forget to send the values to the instrument (with Send button).
Timing and Sync Setup

The Timing & Sync Panel shown in Figure 2-5 allows configuring timing and synchronization. All changes are sent to the instrument immediately. The panel Timing & Sync can be opened using item Timing & Sync from menu Setup or pressing the button Set Timing in main panel.

![Figure 2-5. Timing & Sync](exb018.bmp)

Timing and Sync Settings

The number of rows depends on active channel in instrument. The picture shows the six channels (three phase) version. To change channel configuration, change relevant parameter in window.

1. Averaging Interval - nominal averaging interval. Click on the box and write the value using keyboard or click on the spin on the left side to increment/decrement the value. The actual averaging interval may vary depending on the synchronization signal frequency.
2. Sync Source - selects synchronization source from list of available channels.
3. Sync Level - selects synchronization level in percent.
4. Sync Slope - selects either positive or negative synchronization slope.
5. Sync Filter - selects synchronization source filter cutoff frequency.
7. The status bar shows the performed action. If nothing is done, OK is displayed.
8. Sync On - switches the synchronization on/off.

The panel can be closed by pressing the cross mark in title bar of window.
System Setup

The panel System shows the system configuration (Figure 2-6). The Language can be changed, but NORMA View is not able to change language while running. The application has to be restarted. The panel System can be opened using item System from menu Setup in main panel.

System Information

1 Port - indicates the port, which the instrument is connected to. For TCPIP is IP Address displayed.
2 Measurement Method - indicates the configured measurement method.
3 Instrument Date – shows/modifies current instrument date.
5 Language - shows current language version. You can select the other language from ring. The change takes effect after restart of application.
6 Key Lock - configures the instrument front panel lock. You can select Off, On, Remote state. To unlock instrument front panel it is necessary switch the instrument to the local mode pushing the F6 key (Local) on the instrument.
7 The status bar shows the performed action. If nothing is done, OK is displayed.

The panel can be closed by pressing the cross mark in title bar of window.
Chapter 3

Using NORMA View Basics

<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric</td>
<td>3-3</td>
</tr>
<tr>
<td>Numeric Values</td>
<td>3-3</td>
</tr>
<tr>
<td>Delete Numeric Config</td>
<td>3-4</td>
</tr>
<tr>
<td>Delete Numeric</td>
<td>3-4</td>
</tr>
<tr>
<td>Save Data</td>
<td>3-5</td>
</tr>
<tr>
<td>Save Data</td>
<td>3-5</td>
</tr>
<tr>
<td>Data Saver Table</td>
<td>3-6</td>
</tr>
<tr>
<td>Data Table</td>
<td>3-6</td>
</tr>
<tr>
<td>Chart Recorder</td>
<td>3-7</td>
</tr>
<tr>
<td>Chart</td>
<td>3-8</td>
</tr>
<tr>
<td>Available Measurement</td>
<td>3-10</td>
</tr>
<tr>
<td>How to Select Measurement Function</td>
<td>3-10</td>
</tr>
<tr>
<td>Integration Available Functions</td>
<td>3-11</td>
</tr>
<tr>
<td>How to Select Function</td>
<td>3-11</td>
</tr>
<tr>
<td>List of Plug-Ins</td>
<td>3-11</td>
</tr>
</tbody>
</table>
**Numeric**

This panel as shown in Figure 3-1 allows the user to configure measured function. NORMA View allows creating many numeric panels. The number of displayed numeric panels is limited only by available memory.

The panel Numeric can be opened using item Numeric from menu Measure or pressing the Create Numeric Panel button in main panel. In both cases the new Numeric panel is created.

**Numeric Values**

1. Measured values are in this panel displayed in format "Name" "Value" "Unit". Default values are values for phase 1. Click on displayed name to select another measured value or none value.

To select new value the panel Available Measurement will be displayed. Refer section, Available Measurement for details, how to select a new value.

2. The status bar shows the performed action. If nothing is done, OK is displayed.

There are a few buttons/rigs in the lower part of the panel.

3. Phase 1 - this ring allows selecting predefined or saved group of measured values. Click on ring and select wanted group.

4. Save - allows saving active measured values as user defined numeric configuration. Press this button and the File Dialog will be displayed, as shown in Figure 3-2. Fill in the name of numeric configuration (default name is Test).
Press OK to save user numeric configuration.
Press Cancel to return to numeric panel without saving.

On Top - this button changes the window property. If On Top is on, the numeric panel stays in front of the other windows. Switch this button on to prevent hidden numeric panel.

The panel can be closed by pressing the cross mark in the title bar of the window.

**Delete Numeric Config**

This panel as shown in Figure 3-3 allows deleting the numeric configuration saved on the disc. Only user numeric configuration can be deleted. It is not possible to delete for example Phase 1 configuration.

![Figure 3-3. Delete Numeric Configuration Panel](exb022.bmp)

**Delete Numeric**

- The list on the left side contains the saved numeric configurations. Refer section, Numeric for information on how to save the numeric configuration.
Values displayed on the right side are saved with selected configuration.

Delete Selected Configuration - deletes the selected configuration from the disc. The confirmation message occurs, before the configuration is deleted.

OK - closes the panel.

**Save Data**

NORMA View allows user to store measured values to the text file. The data are stored in format:

- Date
- Time
- Names of measured values separated by tab
- dd.mm.yyyy
- hh.mm.ss
- Measured values separated by tab

*Note*

The values are stored commensurate with regional settings.

All data selections are performed in panel Available Measurement. Refer section, Available Measurement.

**Save Data**

If you want to save measured data just click on item Save Data in menu File. The panel Data Save Panel displays, as shown in Figure 3-4.
Path: file name and path for the data file. A path has to be entered, before saving is started. The button Save Data is inactive until a path is entered.

Continuous/Single Switch - you can select the save mode. Single – each press of Save Data stores one measurement in the selected file. If the list of values was changed and the file exists, user is asked to confirm overwrite the old file and new file is created. Continuous - measurements are stored to the selected file. If the file exists, user is asked to confirm overwrite.

Add - you can add the measured function.

Edit - you can edit measured function in selected row of the table.

Delete - you can delete measured function from selected row of the table.

Reset - you can delete all measured function from the table.

Copy From Numeric - you can copy measured functions from all opened numeric panels to the table.

Save Data - press this button to start the data storage. The button stays pushed, the background color is changed to red and the buttons on the right side are disabled.

Data are saved now to the selected file and the number of saved bytes is displayed in status bar. To stop data saving press the button Save Data once again. For Single measurement the button goes up automatically after the data are stored. Save Data button is active only if a data file is selected.

Table On/Table Off - shows/hide data table displaying. Stored data are displayed in the table. Refer section, Data Saver Table

Data Saver Table

Values stored to the file with Save Data are displayed in the table. It is possible to scroll over the table, but no data analyzes are available. Data are stored in tab-separated format to allow simple import into many programs like Microsoft Excel.

Data Table

The Data Table Display shown in Figure 3-5 is displayed/hidden using the Table On/Table Off button in the Save Data Panel (see Figure 3-4).
Scroll On/Scroll Off - enables/disables auto-scrolling table to the last row. If On, last row is shown during data storage. If you want to scroll over table during data storage manually, switch this button Off. If no data storage is performed, the button state has no effect.

**Chart Recorder**

This panel displays up to six measured values in graphical manner. NORMA View allows creating many chart recorder panels. The number of chart recorder panels is limited only by available memory.

The panel Chart Recorder can be opened using item Chart Recorder from menu Measure or pressing the Create Chart Recorder button in main panel. In both cases the new Chart Recorder panel is created and displayed in minimized version. Click the button Maximize to show the whole panel with two graphs (Figure 3-6).
There are two charts in this panel. Both charts have the same properties.

1. Three measured values are displayed in each chart. Measured values are updated on the defined sample rate. To change the displayed values, click on the box above the graph, in which the value name and unit are displayed.

The panel Available Measurement will be displayed to select a new value. Refer section, Available Measurement for more details about how to select a new value.

2. The status bar shows the performed action. If nothing is done, OK is displayed.

Buttons/rings in the lower part of the panel provide additional functions.

3. Freeze - stops the chart recorder. The buttons Cursor, Zoom and Undo will be enabled now. To start chart recorder again, switch this button off.

4. Cursor - enables cursor handle. The cursor is displayed in the graph in the form of the red vertical line. Snap the cursor and move it to the desired position. The boxes of measured values will display the value in active cursor position.

5. Zoom - enables handglass cursor. Use mouse to select the part of the graph, you are interested in. The selected part will be enlarged.

**Chart**

![Figure 3-6. Chart Recorder](image)
Undo - returns last zoom.

2nd Cursor – enables the second cursor handle. The cursor is displayed in the graph as a cyan vertical line. The new boxes will be displayed below the boxes with measured values. This boxes display the value in active cursor position. Snap the cursor and move it to the desired position.

Minimize - switches between minimize/maximize windows. If the window is minimized, only one chart is shown.

The range of Y-axis can be changed using the Y-axis Range dialog box. Click on Y-axis in graph to display this dialog box (Figure 3-7).

Switch Autoscale? to enable/disable autoscale. If the autoscale is off (no check mark is displayed in box), it is possible to set y-axis range manually. Fill low value into lower numeric box and high value into numeric box above. You can simply click on numeric box and enter the value using the keyboard or increment/decrement value using the spin buttons.

Click OK to accept new values.

Click Cancel to return to the chart without changes.

The panel can be closed by pressing the cross mark in title bar of window.
Available Measurement

The Available Measurement dialog box shown in Figure 3-7 enables quick and easy selection of measurement functions including phase and modifier. This dialog box is available from each panel in which a user can select measurement function.

![Available Measurement dialog box]

Figure 3-8. Available Measurement

How to Select Measurement Function

1. In the table are listed all available measurement functions. No Function text in the first line indicates that no function should be selected. Click on function you want to select.

2. The rings Modifier and Phase changed commensurate with selected function. Select modifier and phase.

Note

The integral modifiers depends on configured integrated functions.

DON'T FORGOT TO SEND THE LIST OF INTEGRATED VALUES TO THE INSTRUMENT AND START INTEGRATION BEFORE LOOKING THEM INTO AVAILABLE MEASUREMENTS. Refer to previous section, Integration Setup, for details.

3. Use OK button to confirm selection.

4. Use Cancel button to return without using selected function.
Integration Available Functions

Figure 3-9 shows the dialog box used for selecting the integrated functions.

![Figure 3-9. Integration Available Functions]( sulfur bmp)

**How to Select Function**

1. The Table lists all available functions that can be integrated. Click on function you want to select.
2. The Phase ring changes according to the selected function.
3. Use the OK button to confirm selection.
4. Use the Cancel button to return without selecting function.

**List of Plug-Ins**

The optional plug-ins have to be Release Date 25. 09. 2003 or newer.

The NORMA View supports next optional plug-ins:

- **Motor** - supports configuration of process interface.
- **Analog Outputs** - supports configuration of process interface analog outputs.
- **Harmonic** - supports spectrum measurement configuration and spectrum data reading.
- **Storage** - supports memory configuration and memory data reading.
# Chapter 4

## NORMA View Plug-Ins

<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plug-In Installation .....................................................................</td>
<td>4-3</td>
</tr>
<tr>
<td>Installation Start .......................................................................</td>
<td>4-3</td>
</tr>
<tr>
<td>Select Action .............................................................................</td>
<td>4-4</td>
</tr>
<tr>
<td>Installation of NORMA View Plug-In .........................................</td>
<td>4-5</td>
</tr>
<tr>
<td>Motor Plug-In .............................................................................</td>
<td>4-5</td>
</tr>
<tr>
<td>Description ................................................................................</td>
<td>4-5</td>
</tr>
<tr>
<td>User Interface ...........................................................................</td>
<td>4-5</td>
</tr>
<tr>
<td>Table .........................................................................................</td>
<td>4-6</td>
</tr>
<tr>
<td>Status .......................................................................................</td>
<td>4-6</td>
</tr>
<tr>
<td>Numeric Panel Example ..................................................................</td>
<td>4-7</td>
</tr>
<tr>
<td>Analog Outputs Plug-In ..................................................................</td>
<td>4-7</td>
</tr>
<tr>
<td>Description ................................................................................</td>
<td>4-7</td>
</tr>
<tr>
<td>User Interface ...........................................................................</td>
<td>4-7</td>
</tr>
<tr>
<td>Table .........................................................................................</td>
<td>4-8</td>
</tr>
<tr>
<td>Status .......................................................................................</td>
<td>4-8</td>
</tr>
<tr>
<td>Available Functions for Analog Outputs ....................................</td>
<td>4-9</td>
</tr>
<tr>
<td>How to Select Measurement Function ........................................</td>
<td>4-9</td>
</tr>
<tr>
<td>Harmonic Plug-In ........................................................................</td>
<td>4-10</td>
</tr>
<tr>
<td>Description ................................................................................</td>
<td>4-10</td>
</tr>
<tr>
<td>User Interface ...........................................................................</td>
<td>4-10</td>
</tr>
<tr>
<td>Configuration Values ...................................................................</td>
<td>4-11</td>
</tr>
<tr>
<td>Graph ...........................................................................................</td>
<td>4-12</td>
</tr>
<tr>
<td>Graph Buttons .............................................................................</td>
<td>4-14</td>
</tr>
<tr>
<td>Table .........................................................................................</td>
<td>4-15</td>
</tr>
<tr>
<td>Status .......................................................................................</td>
<td>4-17</td>
</tr>
<tr>
<td>Buttons ......................................................................................</td>
<td>4-17</td>
</tr>
<tr>
<td>Harmonic Available Measurement ...............................................</td>
<td>4-17</td>
</tr>
<tr>
<td>How to Select Function ................................................................</td>
<td>4-18</td>
</tr>
<tr>
<td>Storage Plug-In ..........................................................................</td>
<td>4-18</td>
</tr>
<tr>
<td>Description ................................................................................</td>
<td>4-18</td>
</tr>
<tr>
<td>Requirements .............................................................................</td>
<td>4-18</td>
</tr>
<tr>
<td>User Interface ...........................................................................</td>
<td>4-18</td>
</tr>
<tr>
<td>Configure Storage .......................................................................</td>
<td>4-19</td>
</tr>
<tr>
<td>Configure Storage Panel .........................................................</td>
<td>4-19</td>
</tr>
<tr>
<td>Status .......................................................................................</td>
<td>4-22</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Buttons</td>
<td>4-22</td>
</tr>
<tr>
<td>Graph Storage</td>
<td>4-22</td>
</tr>
<tr>
<td>Configuration Values</td>
<td>4-23</td>
</tr>
<tr>
<td>Graph</td>
<td>4-23</td>
</tr>
<tr>
<td>Graph Buttons</td>
<td>4-25</td>
</tr>
<tr>
<td>Table</td>
<td>4-27</td>
</tr>
<tr>
<td>Status</td>
<td>4-27</td>
</tr>
<tr>
<td>Buttons</td>
<td>4-27</td>
</tr>
<tr>
<td>Text File Format</td>
<td>4-28</td>
</tr>
<tr>
<td>Available Functions for Storing Data</td>
<td>4-29</td>
</tr>
<tr>
<td>How to Select Measurement Function</td>
<td>4-29</td>
</tr>
<tr>
<td>Available Functions for Sample Values</td>
<td>4-30</td>
</tr>
<tr>
<td>How to Select Function</td>
<td>4-30</td>
</tr>
</tbody>
</table>
Plug-In Installation

Installation Start

The installation process is similar to installation of NORMA View Basic.

1. Insert an installation CD with NORMA View software into your CD-ROM driver and wait for auto start, than follow the instruction on the monitor, as shown in Figure 4-1.

2. If the auto start feature is disabled in your computer, please run setup.exe program in the NORMA View directory on your installation CD.

![Figure 4-1. 1st Screen of Installation Program](exb029.bmp)
Select Action

1. This window will be shown only, if the NORMA View has been installed on your computer (Figure 4-2).

2. Select Reinstall to reinstall NORMA View Basic and install NORMA View Motor Plug-in.

3. If you have installed the newer version of NORMA View on your computer than the version on CD, do not select this option to install plug-in.
   The NORMA View would have been uninstalled from your computer with all installed plug-ins. In this case, select Install Plug-in(s) option.

4. Select Uninstall to uninstall NORMA View Basic and all installed plug-ins from your computer.

5. Select Install Plug-in(s) to install new plug-into installed NORMA View. If the installed version is older than that on CD, the NORMA View Basic will be reinstalled automatically.

![Select the action](exb030.bmp)

**Figure 4-2. Select Action**

Next is the installation similar to NORMA View Basic installation. After installation of NORMA View Basic, the Plug-in is installed.
Installation of NORMA View Plug-In

1. If the installer finds the NORMA View Plug-in on your computer, the next screen will be displayed, as shown in Figure 4-3.

2. Select Reinstall to reinstall NORMA View Plug-in. If the newer version is installed, the installer asks you for confirmation.

3. Select Uninstall to uninstall NORMA View Plug-in.

4. After the installation completes, the computer has to reboot in order to apply new settings.

Motor Plug-In

Description

NORMA View Motor Plug-In is a plug-in for the NORMA View Basic application.

User Interface

Optional plug-in only, this panel is not included in NORMA View Basic.

If the plug-in is installed, the Motor items are displayed in main NORMA View panel, as shown in Figure 4-4. (The item Motor in Setup menu and the button between buttons.) The button can be displayed on another position. The button position depends on installed plug-ins.
The panel Motor can be opened using item Motor from menu Setup (optionally under shadow line) or pressing the Motor button, opens Motor Configuration Panel, in main panel, as shown in Figure 4-5. This panel allows configuring process interface. The process interface has to be available in the instrument, if you want to use this configuration panel. All changes are sent to the instrument immediately.

![Configure Motor](exb033.bmp)

**Figure 4-5. Configure Motor**

**Table**

There are two parts in the table. First configures motor speed and torque, second configures drive.

- **Input** - description of input, it cannot be modified.
- **Gain** - sets the desired gain on input. Click on the box and type the value using the keyboard, or click the spin button on the left side to increment/decrement the value. The value range depends on the specified units.
- **Units** - sets the input units. Select value from the ring.
- **Zero** - sets the input offset in selected units. The zero unit changes automatically according to the specified input unit.
- **Drive** - description of process input, no modification allowed.
- **Type** - sets the drive type. The setting affects calculation of slip and efficiency.
- **PPairs** - sets the number of pole pairs of the drive. This setting is used for slip calculation.
- **Pref** - sets the measured electrical power used for efficiency calculation.

**Status**

The status bar shows the performed action. If nothing is done, OK is displayed.

The panel can be closed by pressing the cross mark in title bar of window.
**Numeric Panel Example**

The numeric panel allows selection of process interface variables, as shown in Figure 4-6.

![Figure 4-6. Numeric Panel Example](exb034.bmp)

**Analog Outputs Plug-In**

**Description**

NORMA View Analog Outputs Plug-In is an optional component for the NORMA View Basic application.

**User Interface**

Optional plug-in only, this panel is not included in NORMA View Basic.

If the plug-in is installed, the Analog Outputs item is displayed in main NORMA View panel in Setup menu.

The Analog Outputs panel can be opened using item Analog Outputs from menu Setup (optionally under shadow line) in main panel. This panel, as shown in Figure 4-7, allows configuring process interface analog outputs. The process interface has to be available in the instrument, if you want to use this configuration panel. All changes are sent to the instrument immediately.
Figure 4-7. Analog Outputs Panel

Table

- **Output** - description of output, it cannot be modified.
- **Mode** - sets the selected output mode. Click on the ring and select the Fixed or Variable mode. Fixed mode means, that the directly specified voltage value will be sent to the output. Variable mode allows user to configure a measurement function, gain and zero for the calculation of the output voltage.
- **Voltage** - configures the output voltage for the Fixed mode or the measurement function for the Variable mode. Click on the box and write the value using keyboard or click on the spin on the left side to increment/decrement the value. For the Variable mode is displayed function name. Click on the name to change it. The panel Available Measurement for Analog Outputs will be displayed (Refer section, Available Functions for Analog Outputs for details).
- **Gain** - sets the scaling for the output. The difference between the actual value of the reference function and the Zero value is multiplied by this factor to calculate the output voltage. This value is displayed only for Variable mode. Click on the box and write the value using keyboard or click on the spin on the left side to increment/decrement the value.
- **Zero** - sets the offset for the output. This value is subtracted from the actual value of the reference function before this difference is multiplied by the Gain setting to calculate the output voltage. This value is displayed only for Variable mode. Click on the box and type the value, or click the spin button to increment/decrement the value.

**Status**

The status bar shows the performed action. No action displays as “OK.”

The panel can be closed by pressing the cross mark in title bar of window.
**Available Functions for Analog Outputs**

This panel as shown in Figure 4-8, is intended for comfortable selection of functions for variable analog outputs configuration including phase and modifier.

![Select Memory Storage Function](eab039.bmp)

**Figure 4-8. Available Functions for Analog Outputs**

**How to Select Measurement Function**

The selection of function is very easy. In the table are listed all available functions.

1. Simply click on function you want to select.
2. The rings Modifier and Phase changed commensurate with selected function.
3. Select modifier and phase.
4. Use button OK to confirm selection.
5. Use button Cancel to return without using selected function.
Harmonic Plug-In

Description

NORMA View Harmonic Plug-in is a plug-in for NORMA View Basic application.

User Interface

Optional plug-in only, this panel is not included in NORMA View Basic.

If the plug-in is installed, the Spectrum items are displayed in main NORMA View panel, as shown in Figure 4-9, (item Harmonic in Measure menu and the button between buttons). The button can be displayed on another position. The button position depends on installed plug-ins.

![Figure 4-9. Main Panel with Spectrum Button](exb043.bmp)

Press the Harmonic button or select the item Harmonic from menu Measure. The panel Harmonic will be opened in minimized mode. Click button Maximize to maximize panel. This panel as shown in Figure 4-10, allows configuring and displaying the Harmonic values. User can configure Stop Frequency and Mode of spectrum calculation (FFT or DFT). At most six values can be monitored in time. The values are displayed into graphs.
Figure 4-10. Spectrum

In the top of panel are placed configuration values. These values are transferred to the instrument after switch on the button On. If spectrum calculation is performed, the changed values are transferred to the instrument before next calculation.

The panel is divided into two parts - top and below. Both parts have the same functionality and properties are independent each to other.

The values can be displayed into one graph, three graphs or table. The view can user select with first button below the graph/table.

Configuration Values

The spectrum parameters are configured using next values.

- Start Frequency - sets the start frequency. This value is always 0 Hz and cannot be modified.
- Stop Frequency - the ring with available stop frequencies. The values in the ring depend on connected instrument. The values for Norma 3000, Norma 4000 and Norma 5000 are available. Default list is the list for Norma 4000.
- FFT/DFT Ring - selects the mode of spectrum calculation.

1. To change the displayed values, click on the box above the graph, in which the value name and unit are displayed (Figure 4-11).
2. The panel Spectrum Available Measurement will be displayed to select a new value. Refer section, Harmonic Available Measurement for details, how to select a new value.

3. If DFT mode selected, the fundamental frequency is displayed above the box with value name.

4. The range or mapping of Y-axis can be changed in Y-axis Range dialog box. Click on Y-axis in graph to display this dialog box.

**Graph**

Values can be displayed into single graph, three graphs or table. The application provides a few features for data analysis in graphs (Figure 4-12).
1. The range or mapping of Y-axis can be changed for each graph in Y-axis Range dialog box. Click on Y-axis in graph to display this dialog box, as shown in Figure 4-13.

2. Switch Autoscale? to enable/disable autoscale.

3. If the autoscale is off (no check mark is displayed in box), it is possible to set y-axis range manually.

4. Fill low value into lower numeric box and high value into numeric box above.
5. You can simply click on numeric box and enter the value using keyboard or increment/decrement value using spin on the left side.
6. Switch Log/Lin to select y-axis mapping (logarithmic/linear). No values are recalculated.
7. This switch changes only value displaying.
8. Click OK to accept new values.
9. Click Cancel to return to the chart without changes.

**Graph Buttons**

There is the group of the small buttons and one ring on the right side of graph(s), as shown in Figure 4-14. The group is visible only for graph(s). For three graphs, work the buttons for all graphs together. It is not possible to set for one graph zoom tool, for second cursor tool and for third hand tool.

![Figure 4-14. Graph Buttons](exb066.sps)

1. **Move Graph** - click this button to move the graph. Click this button. The mouse cursor changes to hand. Now you can snap the graph and move it.
2. **Zoom** - click this button to select the zoom. You can select many zoom modes.
   a. Allows selecting the area in both (x and y) directions.
   b. Allows selecting the area in x direction.
   c. Allows selecting the area in y direction.
d. Undo last zoom (only one step back).
e. Enlarges the graph in all direction around selected point. Each mouse click enlarges the graph with one step.
f. Reduces the graph in all direction around selected point. Each mouse click reduces the graph with one step.

3. Undo Zoom - this button autoscales the graph to visible all curve(s).
4. Centre Cursor - set cursor to the centre of displayed area.
5. Cursor - click this button to move graph cursor. If you click this button, the mouse cursor changes to cursor symbol. The graph cursor has to be enabled using next button. Enable cursor.

Note

Only one button can be selected in time from above three buttons. These buttons works like radio button.

6. Enable Cursor - this button enables/disables cursor in graph. If the cursor is enabled, the shadow box is displayed it the right top corner of graph. In this box is displayed the value in active cursor position. (First line is x-axis second line is y-axis).
7. Snap Cursor - this ring allows user to select the curve for the cursor snap. The ring is available only for Graph 1. The cursors in Graph 3 are always snapped to the curve. The content of the ring depends on selected spectrum values. First item is always Free. Select this item to snap cursor, no curve, or select another item.

Table

The table is simpler than graphs. There are no special buttons for data analyze. The user can see the measured value in numeric format, as shown in Figure 4-15, and export them to the text file.
The values are stored in engineering format with local decimal point. There is a tab separator between columns.

Example for FFT:

<table>
<thead>
<tr>
<th>Frequency</th>
<th>U1rms</th>
<th>Frequency</th>
<th>I1rms</th>
<th>Frequency</th>
<th>P1</th>
</tr>
</thead>
<tbody>
<tr>
<td>0,000000E+0</td>
<td>9,620973E+1</td>
<td>0,000000E+0</td>
<td>4,609704E-2</td>
<td>0,000000E+0</td>
<td>4,384874E+0</td>
</tr>
<tr>
<td>4,166660E+1</td>
<td>2,505533E+2</td>
<td>4,166660E+1</td>
<td>1,195221E-1</td>
<td>4,166660E+1</td>
<td>2,982420E+1</td>
</tr>
<tr>
<td>8,333332E+1</td>
<td>2,246939E+2</td>
<td>8,333320E+1</td>
<td>1,253205E-1</td>
<td>8,333320E+1</td>
<td>2,379660E+1</td>
</tr>
<tr>
<td>1,249998E+2</td>
<td>1,249998E+2</td>
<td>1,249998E+2</td>
<td>1,154018E-1</td>
<td>1,249998E+2</td>
<td>7,049529E+0</td>
</tr>
</tbody>
</table>
Example for DFT:

<table>
<thead>
<tr>
<th>Harmonic</th>
<th>U1rms</th>
<th>Harmonic</th>
<th>I1rms</th>
<th>Harmonic</th>
<th>P1</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>8.683581E+1</td>
<td>0</td>
<td>NaN</td>
<td>0</td>
<td>3.300390E+0</td>
</tr>
<tr>
<td>1</td>
<td>2.450105E+2</td>
<td>1</td>
<td>NaN</td>
<td>1</td>
<td>2.691934E+1</td>
</tr>
<tr>
<td>2</td>
<td>2.450105E+2</td>
<td>2</td>
<td>NaN</td>
<td>2</td>
<td>2.691934E+1</td>
</tr>
<tr>
<td>3</td>
<td>NaN</td>
<td>3</td>
<td>NaN</td>
<td>3</td>
<td>NaN</td>
</tr>
</tbody>
</table>

**Status**

The status bar shows the performed action. If nothing is done, OK is displayed.

**Buttons**

There are a few buttons/rings in the lower part of the panel.

- Graph 1/Graph 3/Table - switches between 1 graph, 3 graphs and table displaying.
- Clear - deletes all value from displayed graph(s) or table.
- Export - exports data from table to text file. This button is available only for table.
- On - enables/disables spectrum counting. Switch this button on to initiate spectrum counting and transfer the data from instrument to the computer. The spectrum counting and reading will be initiated cyclically until the button is switched off.

The buttons On, in above and below button menu, are synchronized. In above menu is this button available only for minimized window. Spectrum counting cannot be initialized, if realtime memory measurement has been performed. (Click on the Clear button in Graph Storage to clear the memory measurement).

- Minimize/Maximize - switches between minimize/maximize windows. If the window is minimized, only above graph is shown. The buttons Minimize/Maximize, in above and below button menu, are synchronized. In above menu is this button available only for minimized window.

**Harmonic Available Measurement**

This panel as shown in Figure 4-16, is intended for comfortable selection of spectrum function including phase. The panel Spectrum Available Measurement is called from panel Spectrum, and looks like panel Available Measurement.
How to Select Function

The selection of function is very easy. In the table are listed all available functions for spectrum calculation. The first row includes text No Function. It allows user to select no function. Simply click on function you want to select. Use ring Phase to select appropriate phase. The ring Phase is changed commensurate with selected function.

1. Use button OK to confirm selection.
2. Use button Cancel to return without using selected function.

Storage Plug-In

Description

NORMA View Storage Plug-in is a plug-in for NORMA View Basic application.

Requirements

User Interface

Optional plug-in only, these panels are not included in NORMA View Basic.

If the plug-in is installed, the Storage items are displayed in main NORMA View panel, as shown in Figure 4-17, (The item Configure Storage in Configure menu, Graph Storage in Measure menu and the Graph Storage button between buttons). The button can be displayed on another position. The button position depends on installed plug-ins.
Working with memory data storage is divided into two separated parts.

- **Configure Storage** - allows configuring parameters of memory storage. (E.g. Block, Sweep, Record Length, Pretrigger, Sparsing, Start Trigger, Stop Trigger and Values that should be stored). Refer section, Configure Storage for details.

- **Graph Storage** - allows displaying the data from memory. Refer section, Graph Storage for details.

**Configure Storage**

Part of Storage plug-in. Allows configuring parameters of memory storage. (E.g. Block, Sweep, Record Length, Pretrigger, Sparsing, Start Trigger, Stop Trigger and Values that should be stored).

**Configure Storage Panel**

Select item Configure Storage from Setup menu to open Memory Storage Configuration panel. This panel, as shown in Figure 4-18, allows configuring memory data storage. All changes are sent to the instrument immediately.

- **Sweep** - selects the sweep realtime or average. Application stores the configured parameters for realtime and average sweep. Settings for realtime are kept after switching to average sweep. If the realtime sweep is selected again, stored values are loaded.

- **Block** - allows selecting the block number. The data will be stored to this block number. Only Block 1 is available now with the instrument.
- Record Length - sets the record length in seconds include pretrigger. For the Average sweep is not possible to select record length shorter than average time. The value range depends on instrument available memory. The user can select MAX to fill all available memory. Click on the right side of this field (the symbol [ ] is displayed for MAX or [s] is displayed for second) to switch between MAX and value in second (Figure 4-19).

![Figure 4-19. Select the Record Length in Second or MAX](exb057.bmp)

- Pretrigger - sets the pretrigger length in seconds. The pretrigger length has to be smaller than record length.
- Sample Factor - specifies that every \( n^{th} \) produced value is saved to memory. For Average sweep the Sample Factor \( \times \) averaging interval may not exceed Record Length.
- Start Trigger - this cluster allows configuring the memory storage start trigger.
- Source - selects the start trigger source from ring.

The available values are:
- Function – condition on an averaged measurement function causes the trigger.
- Manual – the signal is user-generated, such as by pressing a front panel key.
- Bus – will trigger when a *TRG command is received
- Time – will trigger at exact time
- Immediate – no waiting for an event occurs.
- Sync.Sig. – trigger occurs whenever an edge of the synchronization signal is detected. This source is valid only for Realtime sweep (to use the EXTernal signal jack as a trigger the SYNC source must be set to EXTernal).

Next displayed fields depend on selected source.
- Function - this item has no label. It is visible only for source Function and determines the start trigger function. To change the trigger function, click on the field with function symbol. The panel with available function will be displayed. Refer section, Available Functions For Storing Data for details how to select trigger function.
• Slope - selects the start trigger slope from ring. It is visible only for source Function.
• Level - sets the start trigger function level. It isn’t meant the waveform but the RMS. If the value crosses the level line, the trigger will be activated. It is visible only for source Function.
• Time - sets the start trigger time. Time is taken from the instrument not from PC. The format of the time is:
  
  hh:mm:ss
  dd/mm/yyyy

  It is visible only for source Time.
• Stop Trigger - this cluster allows configuring the memory storage stop trigger.
• Source - selects the stop trigger source from ring.

  The available values are:
  
  • Function – the acquisition will stop when either memory is full or the condition on selected function is met, whichever comes first.
  • Manual – the acquisition will stop when either memory is full or the user presses a key, whichever comes first. To stop the memory recording immediately, turn off the memory subsystem.
  • Time - the acquisition will stop at exact time. This item is valid only for Average sweep.
  • Immediate – no waiting for an event occurs. Stops when record length data number has been stored.

  Next displayed fields depend on selected source.
  
  • Function - this item has no label. It is visible only for source Function and determines the stop trigger function. To change the trigger function, click on the field with function symbol. The panel with available function will be displayed. Refer section, Available Functions For Storing Data for details how to select trigger function.
  • Slope - selects the stop trigger slope from ring. It is visible only for source Function.
  • Level - sets the start trigger function level. It isn’t meant the waveform but the RMS. If the value crosses the level line, the acquisition will stop. It is visible only for source Function (Figure 4-20).
**Status**

The status bar shows the performed action. If nothing is done, OK is displayed.

**Buttons**

There are two buttons groups.

- Add - you can add the memory storage function.
- Edit - you can edit memory storage function in selected row of the table.
- Delete - you can delete memory storage function from selected row of the table. At least one function has to be in the table. This button stays inactive, if only one function is in the table.
- Reset - default setting of memory storage function is set. (Only Voltage on phase 1 will be in the list).

The buttons Add and Edit opens the panel like in section, Available Functions for Storing Data.

**Graph Storage**

Part of Storage plug-in. Allows displaying the data stored in instrument memory.

Press the Graph Storage button or select the item Graph Storage from menu Measure. The panel Graph Storage will be opened in minimized mode. To maximize panel, click button Maximize. This panel allows initialization of storing data to the instrument memory and displaying the stored values. User can select the Memory Block number (only 1 available in this moment) and limit number of values returned from instrument. If the number of stored values will be about millions and at most 100 000 samples can be displayed in the graph, only each nth sample will be returned. From the memory are always returned stored values for all configured functions. A maximum of six curves can be displayed into graphs or tables. These values can be selected only from list configured using 4 Configure Storage. All samples from instrument memory can be saved into file.
Configuration Values

Next values allow configuring the data read.

- **Block** - sets the block number from which the data will be read. (Only Block 1 is available now).

- **Points in graph** - the ring on the right side. This ring allows user limit the number of points in the graph. Maximum is 100 000. If the number of points in memory is greater than this limit, application will calculate sparsing and returns each \( n \)th point. Calculated sparsing is displayed in the white field on the right side of the ring. If some values has been read from instrument and are displayed in the graphs, each change this ring, that change the sparsing calls new data read from instrument. No memory store initialization will be performed.

- **Sparsing** - White field on the right side of the ring Points in graph. This indicator displays calculated sparsing. The sparsing is calculated as number of point in instrument memory/max point in graph. See Note below for details about Sparsing.

To change the calculated values, click on the box above the graph, in which the value name and unit are displayed.

The panel Available Memory Storage Functions will be displayed to select a new value. Refer section, Available Functions for Sample Values for details, how to select a new value.

**Note**

*Sparsing means that only each \( n \)th sample is transferred from instrument to graph in NORMA View. This is used for data reduction because maximum number of samples in graph in NORMA View is limited to 100k. Sparsing will have the same effect like reducing sample rate of the instrument, but if you zoom in, the sparsing will decrease, i.e. at certain point you will see all acquired points in graph. If you store the data into a file with NORMA View, all samples will be stored (sparsing = 1).*

**Graph**

Values can be displayed into graph or table, as shown in Figure 4-21. The application provides a few features for data analysis in graphs.
1. The range or mapping of Y-axis can be changed for each graph in Y-axis Range dialog box. Click on Y-axis in graph to display this dialog box, as shown in Figure 4-22.
2. Switch Autoscale? to enable/disable autoscale. If the autoscale is off (no check mark is displayed in box), it is possible to set y-axis range manually.

3. Fill low value into lower numeric box and high value into numeric box above. You can simply click on numeric box and enter the value using keyboard or increment/decrement value using spin on the left side.

4. Click OK to accept new values.

5. Click Cancel to return to the chart without changes.

**Graph Buttons**

There is the group of the small buttons and one ring on the right side of graph(s), as shown in Figure 4-21. The group is visible only for graph(s). For three graphs work the buttons for all graphs together. It is not possible to set for one graph zoom tool, for second cursor tool and for third hand tool.

1. **Move Graph** - click this button to move the graph. Click this button. The mouse cursor changes to hand. Now you can snap the graph and move it.

2. **Zoom** - click this button to select the zoom. You can select many zoom modes. The zooms are a little different in this panel. If the sparsing is greater than 1, each zoom on x-axis performs new date read from instrument. If the sparsing is 1 (each sample was read) the zoom works normal (no new data was will be read).

   a. Allows selecting the area in both (x and y) directions.
b. Allows selecting the area in x direction.

c. Allows selecting the area in y direction.

![Diagram showing options (d, e, f)]

- d. Undo last zoom (only one step back).
- e. Enlarges the graph in all directions around selected point. Each mouse click enlarges the graph with one step.
- f. Reduces the graph in all directions around selected point. Each mouse click reduces the graph with one step.

3. Cursor - click this button to move graph cursor. If you click this button, the mouse cursor changes to cursor symbol. The graph cursor has to be enabled using next button. Enable cursor.

*Note*  
*Only one button can be selected in time from above three buttons. These buttons works like radio button.*

4. Enable Cursor - this button enables/disables cursor in graph. If the cursor is enabled, the shadow box is displayed it the right top corner of graph. In this box is displayed the value in active cursor position. (First line is x-axis second line is y-axis).

*Note*  
*Two cursors are available now in the graph. The behavior of the second cursor is similar to the first.*

5. Snap Cursor - this ring allows user to select the curve for the cursor snap. The ring is available only for Graph 1. The cursors in Graph 3 are always snapped to the curve. The content of the ring depends on selected values. First item is always Free. Select this item to snap cursor to no curve or select another item.

6. Undo Zoom - this button reads the data from instrument for the whole range.

7. Centre Cursor - set cursor to the centre of displayed area.
Table

The table is simpler than graphs. There are no special buttons for data analyze. The user can see the measured value in numeric format, as shown in Figure 4-23.

<table>
<thead>
<tr>
<th>Time</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000E+0</td>
<td>253.89280E+0</td>
</tr>
<tr>
<td>200.146E-6</td>
<td>238.72938E+0</td>
</tr>
<tr>
<td>604.296E-6</td>
<td>222.24102E+0</td>
</tr>
<tr>
<td>808.448E-6</td>
<td>204.47000E+0</td>
</tr>
<tr>
<td>1.018E-3</td>
<td>170.04504E+0</td>
</tr>
<tr>
<td>1.213E-3</td>
<td>135.65080E+0</td>
</tr>
<tr>
<td>1.418E-3</td>
<td>116.30346E+0</td>
</tr>
<tr>
<td>1.627E-3</td>
<td>97.95808E+0</td>
</tr>
<tr>
<td>1.839E-3</td>
<td>79.15004E+0</td>
</tr>
<tr>
<td>2.052E-3</td>
<td>69.10304E+0</td>
</tr>
</tbody>
</table>

Status

The status bar shows the performed action. If nothing is done, OK is displayed.

Buttons

There is one button in the upper part.

- **Read** – allows user to read data from the instrument memory. If no data are available, the error box will be displayed.
- There are a few buttons/rings in the lower part of the panel.
- **Graph/Table** - switches between graph and table displaying.
- **Clear** - deletes all value from instrument memory, graphs and tables. Switches the memory off. If the memory storage has been done, click this button before starting harmonic measurement. It is not possible performing the data storage and harmonic measurement in time.
• Save To File - Click this button to read all data from the instrument and save them to the file. If the data are read from file, all data will be read and stored to the file (the zooms are ignored). If the data are read from file, only the displayed (zoomed) part will be stored to the file. Only zoom on x-axis has effect for this function. There are two available file formats.
  o Binary - the "bin" file extension. Binary file will be saved. The user can load this file later using the Load File button Load. The file name is selected in standard dialog window. Default extension is "bin" - it means, if the user writes no extension, "bin" is added to the file name and file is saved in binary format.
  o Text - the "txt" file extension. Text file is saved. See below for the format of text file.
    Only "txt" can be used for text format! Any other extension saves the file in binary format. The text file cannot be load into graph or table later. Load File - loads the previously stored binary file. Until this button is pressed, you can work on the data from loaded file. Instead Block number the File name will be displayed.

• Config – opens the Configure Storage panel. (Refer Configure Storage).

• Continuous - enables/disables continuous memory data initialization and reading. Switch this button off to stop continuous data reading. Last init and data read will not be interrupted. It is strongly recommended to use a low number of points in graph (1000 is the best) for this function.

• Single - initiates the memory storage and when the data are available, reads them and displays into the graphs (tables). The waiting for data and data read can be interrupted switching this button off.

• DSO - initiates the DSO measurement. Configures instrument for 5 signal period, 500 points per memory and runs continuous measurement. If no synchronization frequency is available, the 50 Hz is assumed.

• Minimize/Maximize - switches between minimize/maximize windows. If the window is minimized, only above graph is shown.

**Text File Format**

<table>
<thead>
<tr>
<th>Time</th>
<th>U1</th>
<th>I1</th>
</tr>
</thead>
<tbody>
<tr>
<td>0,000000E+0</td>
<td>311,63345E+0</td>
<td>48,24626E-3</td>
</tr>
<tr>
<td>52,73452E-6</td>
<td>311,79858E+0</td>
<td>79,37288E-3</td>
</tr>
<tr>
<td>105,46904E-6</td>
<td>311,96368E+0</td>
<td>113,44834E-3</td>
</tr>
</tbody>
</table>
Available Functions for Storing Data

This panel as shown in Figure 4-24, is intended for comfortable selection of functions for memory storage configuration including phase and modifier. The list depends on selected Sweep for Realtime sweep the sampled values are stored. For Average Sweep numeric (average) values are stored.

![Select Memory Storage Function](image)

**Figure 4-24. Storage Available Functions**

How to Select Measurement Function

The selection of function is very easy. In the table are listed all available functions. Simply click on function you want to select. The rings Modifier and Phase changed commensurate with selected function. Select modifier and phase.

1. Use button OK to confirm selection.
2. Use button Cancel to return without using selected function.
Available Functions for Sample Values

This panel as shown in Figure 4-25, is intended for comfortable selection of configured memory storage function. These functions are configured for fast memory storing in the unit. The panel Available Memory Storage Functions is called from panel Graph Storage.

![Available Memory Storage Functions](eab065.bmp)

**Figure 4-25. Available Memory Storage Functions**

How to Select Function

The selection of function is very easy. In the table are listed all configured memory storage functions. The first row includes text No Function. It allows user to select no function. Simply click on function you want to select.

1. Use button OK to confirm selection.
2. Use button Cancel to return without using selected function.